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System Requirements 

CPU: Intel Xeon E5-1650 @ 3.20GHz, or Intel Core i7-3930K @ 3.20GHz 

RAM: 12GB RAM (minimum)  

HDD: 150GB SATA 10K ,  15K RPM  or SDD 

OS: Windows 7 Professional, or Ultimate 64-bit 

 

Before starting the software installation, you need to ensure that you have a 
clean version of Windows 7 with nothing installed.  In order to do so, you will 
need to make sure of the following:  

□ There are no applications installed or currently running. 
□ There are no antivirus programs installed. 
□ No software programs are blocking the Port 80; such as GoToMeeting, 

WebEx, TeamViewer, etc.   
□ The computer you’re planning to install the software on has the printer 

and feeder on the same network. 
□ You will need 2 static IP addresses, and 3 network cables. 
□ Ensure your user account has Administrator privileges on the local 

computer.  
 

Please ensure you follow every step in order.  
If a step is missed, the software will need to 
be uninstalled then reinstalled. 
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1. Limitation of Liability 
 

Uninet total liability to the purchaser, or to any third party, for damages from any and all causes 
whatsoever, regardless of the form of action, whether in contract or in tort, including negligence, and any 
infringement of proprietary rights or any misappropriation or unlawful use of any proprietary rights or 
property of any third party shall, in the aggregate, be limited to purchase price actually paid by the 
purchaser for the product relating to the damages. The limitation of liability provisions of this agreement 
reflect an informed voluntary allocation of the risks (known and unknown) that may exist in connection 
with the provisions of the goods and services provided hereunder by Uninet and that such voluntary risk 
allocation represents a fundamental part of the agreement reached between Uninet  with the purchaser.   
 
Uninet shall not be liable for any special, direct or indirect, incidental, consequential, exemplary, punitive 
or any similar or other damages of any nature suffered by the purchaser whatsoever including, without 
limitation, loss of use or lack of availability of the purchaser facilities, including its computer resources 
and any stored data, loss of profits or revenue, or other commercial loss, or any claim for contribution or 
indemnity in respect of any claims against the purchaser, regardless of whether Uninet has been advised 
of the possibility of such damages. 
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2.  ICOLOR 900 Warranty 
 

Uninet (Uninet) warrants the ICOLOR 900 (Product) to be free from defects in materials and workmanship and will 
remedy any such defect according to the terms of this Limited Warranty. 

   
Uninet warrants the Product to be free from defects in material and workmanship occurring under normal usage, 
within the normal operating range and duty cycles specified.  If the Uninet Customer Service Representative 
Department receives notice of such defects during the warranty period, Uninet at its option, and within a 
reasonable time, will repair or replace the defective Product.  A certified Uninet service representative shall 
perform repairs, and such repairs, at the option of Uninet, may be performed at the customer site, a dealer site, 
a service depot or the factory.  Replacement Product, at the option of Uninet, may be either new or equivalent 
in performance to new.  Delivery is defined by a signed and dated receipt from the original carrier or Uninet 
dealer delivering the Product, or down time for repair and replacement. 
 
Uninet does not warrant the operation of the Product to be uninterrupted or error free.  Uninet assumes no 
liability for and holds itself harmless against any claims of consequential costs or damages which may arise 
from interruption or error in the operation of the Product. 
 
Uninet does not warrant defects, malfunctions and/or failures, which in its opinion, result from conditions of 
improper use, abuse, neglect, operation outside the published environmental specifications, improper site 
preparation and maintenance, the use of unqualified or unauthorized media (papers, films, toners, inks, fusers 
or belts), inadequate preventative maintenance, unauthorized modifications or unauthorized maintenance.  
Such conditions shall render this warranty void and otherwise release Uninet from its liability under this Product 
warranty. Consumables are non-warranty items. 
 
All product returned to factory must be accompanied by an RMA number, obtained by calling the Uninet Service 
Department at 403-204-5200 or as otherwise instructed.  Shipping and handling charges to vendor for repair 
are the sole responsibility of the customer.  Uninet will cover shipping charges on the return of the repaired unit 
for the term of the warranty as stated above.  Shipping will consist of Standard Shipment level or Best Effort. 
Accelerated or Premium Shipping Service is available but costs will be fully born by customer.  Any international 
duties and taxes payable on transporting the repaired unit across international borders will be the responsibility 
of the customer.  The ICOLOR 900 Printer is a Canadian made product and therefore falls under the 
import/export laws of NAFTA.   
 
A written receipt for the Product, showing the date of purchase, dealer’s name, and both the model and serial 
number/PID’s of the Product must accompany any request or claim for work to be performed under this Limited 
Warranty. 
Additional information on obtaining service under this Limited Warranty or for obtaining Extended Warranty 
coverage contact  Uninet directly at 800-221-3516. 
 
 
Uninet or its authorized service partner will repair, or at its option replace, at no charge, any defective 
component(s) of the Product for a period of one (1) year from the date of purchase.  This Limited 
Warranty extends to the original purchaser only.  This Limited Warranty does not extend to consumable 
items.  

 

7 



 

3. Safety Information    
 
120 Volt Models 
  

Your Uninet product has been carefully designed to give you years of safe, reliable performance. As with all 
electrical equipment, there are a few basic precautions you should take to avoid hurting yourself or damaging the 
product.  
 
 •  Save all provided documentation for future reference.  
 •  Read and follow all warning and instruction labels on the product itself.  

• Unplug the product before you clean it. Use only a damp cloth; do not use liquid or aerosol 
cleaners.  

•  Place your product on a firm, solid surface. If placed on something unsteady, it may fall and be 
damaged. If placed on a soft surface, the vents may be blocked, causing the product to 
overheat.  

•  Protect your product from overheating. Make sure no obstructions block the openings of the 
product. Do not put the product on or near a heat source (such as a radiator or heat register). 
Keep the product out of direct sunlight.  

• Always use this product in a well ventilated area. Allow enough room around the product for 
adequate ventilation and easy access to the paper trays. If the product is placed in any kind of 
enclosure, make sure the enclosure is well ventilated.  

• Do not use the product near water. Do not spill liquid of any kind on it.  
•  Be certain that your power source matches the rating listed on the back of the product. If you 

are not sure, check with your dealer or local power company.  
• Do not connect this product to an uninterruptible power supply (UPS).  
•  Your product has a grounded, three-prong plug as a safety feature. This plug only fits into a 

grounded outlet. If the plug does not fit, the outlet may be an older, non-grounded type. Contact 
an electrician to have the outlet replaced. Do not use an adapter to defeat the grounding.  

•  Install the product near an easily accessible power outlet.  
•  Avoid damaging the power cord. Do not put anything on it or place it where it will be walked on. 

If the cord becomes damaged or frayed, replace it immediately.  
•  If you are using an extension cord or power bar with the product, make sure the total amperes 

required by all the equipment on the extension is less than the extension’s rating. The total 
ratings of all equipment plugged into the outlet should not exceed 15 amperes.  

• Do not poke anything in the ventilation slots of the product. You could get an electrical shock 
or cause hazardous electrical arcing, which could cause a fire.  

• Aside from the routine maintenance described in the documentation, do not try to service the 
product yourself. Removing the cover may expose you to shocks or other hazards.  

•  Do not make any adjustments other than those outlined in the documentation. You may cause 
damage that will require extensive repair work. The provided documentation explains how to 
get your product serviced by qualified Uninet technicians. If anything happens that indicating 
your product is not working properly or has been damaged, unplug it immediately and follow 
the procedures in the provided documentation for having your product serviced.  

 
Here are some of the things to look for.  
 
•  The power cord or plug is frayed or damaged.  
•  Liquid has been spilled into the product or the product has been exposed to water.  
•  The product has been dropped, or the cabinet is damaged.  
•  The product does not function normally when following the operating instructions.  
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220/240 Volt Models 
  

This product has been carefully designed to give years of safe, reliable performance. As with all electrical 
equipment, however, there are a few basic precautions that should be taken to avoid injury or damage:  

  

 
Ensure this and all other documentation is both read carefully and retained for future reference.  

 
Ensure all warning and instruction labels on the product are read, understood and followed in order to prevent any 
risk of injury.  

 
This product may be heavy. Please check the weight of the product and take all necessary precautions to prevent 
the risk of personal injury.  

 
The product must be placed on a flat solid surface strong enough to support its weight to prevent any risk of injury.  

 
Ensure that there is adequate ventilation all around the product to prevent overheating and any risk of fire.  

 
Keep the product away from direct heat sources such as radiators and out of direct sunlight to prevent any risk of 
overheating. 

 
The power supply required for this product is 220-240 VAC, 50/60 Hz. (For any DC powered product, the figures are 
9.6- 31.2VDC, 4-1.8A.) Refer to your product’s rating label on the machine for full power rating details. Ensure that 
you have a suitable power supply before connecting the product. If in doubt contact your dealer or check with your 
local power provider.  

 
Ensure both the product and mains power switches are in the OFF position before connecting the AC power cable.  

 
Do not connect or disconnect the power plug with a wet hand as this may cause electric shock. 

 
Always hold the power plug to connect/disconnect the power cable to/from the mains socket. Unplugging by pulling 
on the cable can cause fraying and may lead to fire or electric shock.  

 
This product has an earthed plug as a safety feature and will only connect to an earthed socket. Do not attempt to 
defeat the earthing or there is a risk of fire or shock.  

 
If using an extension cable or power strip ensure that the total current rating (amperes) of all connected equipment is 
less than the maximum rating of the extension cable, power strip or wall outlet. If the product is already supplied with 
a fitted power strip then no additional power strip or extension cable should be used to connect to the mains wall 
outlet. Otherwise, fire or shock may occur.  

 
Ensure the power cable is routed so as not to be damaged or cause a trip hazard. If the cable becomes frayed or 
damaged replace it immediately to prevent any risk of shock.  

 
Do not twist, constrict or knot the power cable as this can cause overheating which may lead to fire or electric shock.  

 
Ensure the power socket to which the product is connected is easily accessible at all times and not obstructed.  

 
Use only the power cable supplied. Using a power cable not intended for this product may lead to fire or electric 
shock.  

 
To avoid risk of fire and electric shock, do not use the power cable supplied with this product for any other electrical 
equipment.  

 
If you do not connect the power cord or any other cables only as directed in the User’s Guide, this may result in a 
fire.  

 
It is recommended that the machine is switched off prior to opening covers; otherwise there is a risk of electric 
shock.  

 
When the product cover is open, do not touch the fuser unit or print head as you may receive burns. Allow it to cool 
before touching.  

 
If the product casing gets extremely hot or smoke, unusual smells or abnormal noises are emitted from the product, 
there is a risk of fire. Unplug the mains connector and contact your Uninet.  

 
If the product has been knocked over or damaged, there is a risk of electric shock, fire and/or injury. Unplug the 
mains connector and contact Uninet.  

 
If any liquid (for example water) is allowed to enter the product, there is a risk of fire. Unplug the mains connector 
and contact your Uninet.  

 
Do not place containers containing liquid on the product as electric shock, fire and/or injuries may occur. 

 
If any foreign objects (for example clips) are allowed to enter the product, there is a risk of electric shock, fire and/or 
injury. Unplug the mains connector before removing the object.  
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Do not introduce foreign objects into the ventilation holes or operate this product with any covers open or doors 
removed as electric shock, fire and/or injuries may occur.  

 
Do not use an extremely flammable spray near the product as the product contains high temperature parts that may 
cause a fire.  

 
Switch the product off before cleaning to prevent any risk of injury. Clean using a damp cloth. Do not use liquid or 
aerosol cleaners.  

 
Ensure loose clothing and hair is kept clear of moving parts when the product is in operation to prevent possible risk 
of injury.  

 
Do not carry out any operations on the product that are not specified in the User’s Guide. This may result in electric 
shock, fire and/or injury.  

 
Do not touch the battery if one is fitted to the product. There is a risk of explosion if the battery is replaced by an 
incorrect type. The product battery should not require replacement during the life of the product.  

 
Do not throw toner cartridges or image drum cartridges into a fire as you may receive burns from a dust explosion.  

 
After installing additional memory, hard disk drive, or any other internally fitted option, any covers removed or doors 
opened must be closed or replaced and secured to prevent risk of fire.  

 
The acoustic noise of this product is less than 70 dB (A) as measured in accordance with EN ISO 7779.  

 
The operating condition range for your product is: 10 to 32°C and 20 to 80% RH. Operation of the product outside 
this range could result in damage to the product.  

 
If a scanner, finisher etc. is fitted, exercise care when moving these items so as to avoid risk of entrapment or 
personal injury.  

 
If the product is installed on a cabinet or high capacity feeder, ensure wheel locks are applied once placed in   final 
position for use, to prevent risk of movement or injury.  
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4. Introduction to the IColor 900 
a. Unpacking the Feeder 
 

STEP 1 of 4  STEP 2 of 4 

 

 

 
Cut the ties and remove the tape from the box.  Lift the top sleeve upwards exposing the feeder. 

 

STEP 3 of 4  STEP 4 of 4 

 
 
 
 
 
 

  
 
 
 
 

 

Using two or three people lift the feeder out of 
the bottom foam packaging. 

 Place the feeder on a flat level surface. 
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b. Unpacking and Setting Up the Printer 
 

STEP 1 of 23  STEP 2 of 23 
 

 
 

 

 

Cut the ties and remove the tape from the 
printer box. 

 Remove the top sleeve.  

 

STEP 3 of 23  STEP 4 of 23 
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Remove the accessory box and corner pieces.  Using two or three people, lift the printer and place 

it on the feeder, making sure the printer is level on 
the feeder. 
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STEP 5 of 16  STEP 6 of 16 
 

 
 

 

 

When placing the printer on the feeder, ensure 
you are aligning the printer with the pins located 
on the top back of the feeder. 

 ICOLOR 900 should be similar to this diagram when 
full assembled. 
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Check all the components are present before assembling: 
(1) Printer 
(2) Light-shield bags, paper tray media labels, LED lens cleaning pad 
(3) Power Cable 
(4) Ferrite Core 
(5) CD (includes User Guide, Warranties, and Drivers) 
(6) Toner Cartridges 

 

STEP 7 of 23  STEP 8 of 23 
 

 
 

 

 

Remove any shipping tape.  Lift the top cover. 

 
 

STEP 9 of 23 

 
1. Lift the operator panel (a), open front cover (b), remove tape (c) 
2. Close the front cover and adjust the operator panel (d). 
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STEP 10 of 23  STEP 11 of 23 

 

 

 
Remove colored image drum packing pieces. 
DO NOT remove the actual image drums.  

 Remove tape 

 
STEP 12 of 23  STEP 13 of 23 

 

 

 

Remove protective sheet  1. Remove colored locks (b). 
2. Remove tape then remove colored seals (a). 
NOTE: Be sure all tape is removed from image drum 
cartridges. 

 
STEP 14 of 23  STEP 15 of 23 
 
 

 

 

 

1. Shake toner cartridge from side to side to 
distribute toner (a). 
2. Remove sealing tape from toner cartridge bottom 
(b). 

 Align the notch on the end of the toner cartridge with 
the tab (a) in the image drum, and then lower the 
toner cartridge into the image drum. Press down to 
make sure it is seated correctly. 
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STEP 16 of 23  STEP 17 of 23 

 

 

 
1. Lock toner cartridge with blue lever. 
2. Repeat these steps for remaining toner cartridges. 

 Close the top cover. 
 

 
 

STEP 18 of 23  STEP 19 of 23 

 

 

 
1. Pull out the paper tray (a). 
2. Remove the colored shipping retainer (b). 
3. Insert the appropriate media size label (c). 

 Load paper. 
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STEP 20 of 23  STEP 21 of 23 

 

 

 
1. Set guides (a, b) to paper size. Make sure the paper 
guides are snug against the paper. 
2. Close the paper tray (c). 
 

 Install the paper catcher. 
1. Lift cover where paper catcher is placed. 
2. Align tabs on catcher in notches on printer. 
3. Press down until catcher is fully seated. 

 
STEP 22 of 23  STEP 23 of 23 
 

 

  

 

1. Insert the power cable into the feeder. 
2. Insert the power cable into the printer. 
3. Turn the printer on. 
 
B – power switch  

 In order to reduce electromagnetic interference—
”noise” that interferes with TVs or other 
appliances—you must place the included ferrite 
core on the network cable. 
1. Loop the cable as shown placing the core about 

1 inch from the connector on the printer end.  
Note: The network cable is not provided. 

2.   Connect the network cable between the printer 
and the Ethernet hub or router. Install the 
parallel cable if used. 
Note: Install the printer software BEFORE 
connecting the USB cable. 
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5. Loading Media 
 

IMPORTANT: Use with Media with a maximum width of 12.9" 

Maximum Print width: 12.6" 

 

 

Identify the three doors and cover for the feeder. 

 

 

  

Guide Door Media Door 

Cutter Cover 

Extension 
Arm 

Load Door 

Spindle Pin 

Guide Channels 
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STEP 1 of 7  STEP 2 of 7 

 

 

 
Open the Media Door. 
 
Before loading the roll, ensure the sides of the roll are 
completely flat. 
 
Insert a roll paper as shown, ensuring you’re holding the  
roll on the side and the media is flat and does not cone.     
If this is not done properly, there will be a tracking 
problems. 
 
Ensure the roll is pushed all the way into the feeder 
against the back, red Extension Arm. 

 Lift the Extension Arm back up into position making 
sure both the Plunger and Extension Arm lock.  
 
The Extension Arm should be rubbing on the roll 
slightly to provide some back tension (drag).  This 
also ensures the Guide Channels will be tight to the 
media. 

 

STEP 3 of 7  STEP 4 of 7 

 

 

 
Open the Load Door at the bottom front of the feeder 
by releasing the two yellow latches. 
 

 
 
 
 

Place the media three quarters of the way up 
the path so it has covered the paper sensors 
completely. 
 

Guide Channels 

Tension Swing 

Load Door 
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Open the Guide Channels. Feed the media under the 
orange Tension Swing as shown. 

 Place the paper evenly between the Guide 
Channels and hold it steady with one hand. 

STEP 5 of 7  STEP 6 of 7 

 

 

 
 

Ensure the Channel Gap (the distance between the 
edge of the paper and the Guide Channel) is less than 
0.5mm on each side and the paper aligned with the 
right side Guide Channel. 
 
Make sure the Channel Gap is not too small so that 
the paper does not fit between the Guide Channels.  
The paper should lay flat against the back of the 
feeder.  If the media does not fit, re-measure the 
width of the roll and use the software to send the 
width to the printer. 
 
Close the Guide Channels and Load Door. 

 Press the Load button to load the media.  
 
The roll will begin to load and cut off a section for 
proper alignment.  Using caution, open the cutter 
door and carefully remove the piece of cut paper. 
Close the cutter door. 
 
Note: Depending on the type of media being 
used, the paper may fall inside the feeder.  Use 
caution when retrieving cut media. 

STEP 7 of 7 

 

Channel Gap 

 

Remove cut 
piece of media. 
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6. Installing  APEX2Print Software 
 

STEP 1 of 8 
 

 
 
Before proceeding with this installation log into your computer with an Administrator account. 
Navigate to the installation folder provided by your vendor. DO NOT insert the dongles at this point.  

 

STEP 2 of 8 
 

The control panel screen should look like this after a 
few moments. Press the Done button. The media will 
then load and the feeder will return to Idle status. 
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Navigate to the 2) Install RIP vR2 Folder > Run the Prepare_Uninet_RIP_v2.1.exe file. 
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STEP 3 of 8 
 

 
 
The KEYLOK and Sentinel Drivers will install. 
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STEP 4 of 8 
 

 
 

 
 
 
The Dongles (            ) should be inserted at this stage. Click the “Install Dongles then Click to 
Continue” button. 
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STEP 5 of 8 
 

 
 
Click Done. 

 
 

STEP 6 of 8 
 

26 



 
 

 
Navigate to the 3) Install APEX2Print folder> Run the APEX2Print_Install.msi file >Click Next >. 
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STEP 7 of 8 
 

 
 

 
Click Next > on the Select Installation Folder Window> Click Next on the Confirm Installation Window. 

 
 
 

STEP 8 of 8 
 

 
 

 
The Installation will proceed. Click Close on the Installation Complete Window.  
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7. APEX2Print Interface 
 

 

 

 
 
 
 
 

 

1.Toolbar                           2.Preview Screen       
3.Print Settings                 4.Image List 
5.Rip Options     

 
Note: Before launching APEX2Print make sure the two dongles are inserted 
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8. First Time Setup 
a. Setting up the IP Addresses 
In order to connect to the IColor 900, you need two predetermined static IP Addresses and two network 
cables, one for the printer and feeder.  
 
Setting the IP address on the ICOLOR 900 

STEP 2  STEP 2 

 

 

 
Press Menu on the printer display panel to enter the 
printer menu.  Scroll down and select Admin Setup 
to enter. 

 
 
 
 
 

Using the up arrow keys, enter the password aaaaaa 
(six lower case a’s).  Select Enter. 

 

STEP 3  STEP 4 

 

 

 
Select the Network Setup menu.  

 
 
 
 

Scroll down to the IP Address and select Enter. 
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STEP 5 

    
Use the up arrow keys to enter the IP Address, hitting 
enter to move right to the next column.  When a * 
(asterisk) symbol appears, the IP Address has been 
saved.  Select Online to finish. 
Write this IP address down as you will need to 
input it into the software. 

 
Setting the IP Address on the Feeder 

The IP address, subnet mask and default Gateway for the feeder can be configured directly from the 
front panel menu on the feeder.  
1. Press Online to turn the feeder offline.  
2. Press the MENU button until Page 3: Network Settings is shown. Press the down arrow key and 
select it. 
3. Press the down arrow key to: IP Address  
4. Hold down the Select key until an arrow flashes beside the IP address. Set each part of the IP address 
as required, using the UP and DOWN arrows. Press save after each entry and then select to move to the 
next set of numbers.  
5. When the address is set, hit save.  
6. Hit the down arrow key and select exit.  

6. Press the down arrow key again to select and enter the subnet mask. The default subnet mask is 
255.255.255.0. If that needs to be changed, follow the same procedure as for the IP Address.  

7. Hit the down arrow key and select exit. Use the same procedure to set the Gateway as used to set 
the IP Address.  

8. Write this IP address down as you will need to input it into the software. 
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b. Input IP addresses into APEX2Print. 
 

 
 
c. Selecting a Media ID 
 

STEP 1 
 

 
 

From the APEX2Print toolbar click on Setup Options 
> IP Addresses. 

 Step 2 
 

 
 

Input the IP Addresses that were setup for the 
Printer and Feeder> Click Save. 

STEP 1 
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*To create or edit custom media please refer to the appendix  
 
  

 
 

To select the media of choice, click Media tab on the APEX2Print toolbar> Select the correct Media ID 
you are using and double click on that Media ID to use the predefined settings required for using that 
specific media type. 
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d. Setting up the Cost Calculator 
 
 

 

 

 

 

 

 

 

 

 

 

  

STEP 1 
 
 
 
 

 

 
 

 
 

From the APEX2Print toolbar click on Setup Options 
> Cost Calculator. 

 Step 2 
 

 
 
Input the price paid for each consumable. This will 
calculate the cost per label. This value will appear 
in the Image List. 
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e. Changing Units of Measurement  
 
 

 

 

 

 

 

 

 

 

 

 

 

  

STEP 1 
 
 

 

From the APEX2Print toolbar click on Setup Options 
> Display Options. 

 Step 2 
 

 
 
Choose Measurement Units in either Imperial (in.) 
or Metric (mm). To apply settings click Save. 
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f. Changing the Color Registration 
 

 

 

 

 

 

  

STEP 1 
 

 
 

 
 
 

From the APEX2Print toolbar click on Setup Options > Color Registration. 

STEP 2 
 

 
 

 
 

Click Print Registration Plot. 
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STEP 3 
 
 

 
 
 
 

The printer will print a similar page that will aid in determining the proper registration values across CMY. 
Using a printer's loupe, or best judgment, the correct values can be determined. In this case, the correct 
values are as follows: C:6 M:4 Y:0; this is because the pixels are perfectly filled within the boxes.  
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STEP 4 
 
 

 

With the values determined: C:6 M:4 Y:0. The following adjustments can be made to the Color 
Registration Form. Click Apply to set. 
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g. How to View Cost Report 
 

From the APEX2Print toolbar click Cost Report.  The Cost Report will be displayed. Notice that 3 PDF files 
are in the job and each are separately calculated. The TOTAL COST of all jobs is calculated at the bottom 
of the page along with the TOTAL LENGTH. 

STEP 1 
 

 
 

Cost Calculation Report 
------------------------------- 
 
-----> General Information <----- 
 
Media Name  : 11001 
Media Width : 12.9 in 
Gutter      : 0.125 in 
Alley       : 0.125 in 
 
******************************* 
Job Set #1 -- Column #1 of 3 
 
PDF Name : 2x2.pdf 
 
Label Size : 2 x 2 in 
 
K Percentage = 2.2% 
C Percentage = 37.0% 
M Percentage = 13.1% 
Y Percentage = 5.9% 
 
Toner Cost per Label(CMYK) = 0.0075 
 
Total Length Column #1 = 1.77 feet 
Total Labels To Print  = 10 
Total Toner Cost(CMYK) = 0.0752 
Total Cost per Label   = 0.0086 
Total Cost per Job     = 0.09 
 
**************************** 
* Job #1 Total Cost = 0.09 * 
**************************** 
******************************* 
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Job Set #1 -- Column #2 of 3 
 
PDF Name : 2x2_green.pdf 
 
Label Size : 2 x 2 in 
 
K Percentage = 3.0% 
C Percentage = 45.5% 
M Percentage = 8.2% 
Y Percentage = 57.1% 
 
Toner Cost per Label(CMYK) = 0.0148 
 
Total Length Column #2 = 1.77 feet 
Total Labels To Print  = 10 
Total Toner Cost(CMYK) = 0.1479 
Total Cost per Label   = 0.0158 
Total Cost per Job     = 0.16 
 
**************************** 
* Job #2 Total Cost = 0.16 * 
**************************** 
******************************* 
Job Set #1 -- Column #3 of 3 
 
PDF Name : 2x2_pink.pdf 
 
Label Size : 2 x 2 in 
 
K Percentage = 2.3% 
C Percentage = 13.2% 
M Percentage = 48.5% 
Y Percentage = 6.0% 
 
Toner Cost per Label(CMYK) = 0.0091 
 
Total Length Column #3 = 1.77 feet 
Total Labels To Print  = 10 
Total Toner Cost(CMYK) = 0.0905 
Total Cost per Label   = 0.0101 
Total Cost per Job     = 0.10 
 
**************************** 
* Job #3 Total Cost = 0.10 * 
**************************** 
   **************************** 
   * TOTAL COST   = 0.34 * 
   * TOTAL LENGTH = 1.77 Feet * 
   **************************** 
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h. Saving and Loading Page Information 
 

 

 

 

 

  

STEP 1 
   

    
 

The Page Information Settings can be saved and loaded for later use. Click File> Save Page 
Information> Select a location> Type a file name> Click Save. To Load a Page Information file, click 
File> Load Page Information>Select the Page Information file's location> Select the Page Information 
file> Click Open. 
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9. Before Printing 
 

a. Measuring your Media 
 

Measure Width of Paper, Horizontal and Vertical Gaps between labels (if applicable), and input these 
values into APEX2Print.  

Option 1: For Die cut labels with gaps (For Die Cut Media Instructions see Appendix: Die Cut Media 
Instructions). 
(Uses gap between labels for sensor alignment) 
 
 
 
 

 

  
Measure this distance and Measure this distance 
and input into Gutter                                                      input into Alley                                                                                      
                                                                                          
 
 
 

 

Option 2: For Die Cut labels without gaps 

(Uses black line for sensor alignment) 
Measure the thickness of the black line. 
Input this value into Gutter 
 

 

If the Label has more than one column of labels, measure distance between labels horizontal and input 
value into Alley 

Gutter: Measures the distance between 
labels by using the horizontal gap  

Alley: Measures the distance between 
labels by using the vertical gap  
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Input the Gutter and Alley values here 

 

b. Selecting Media 
 

Before printing, you must select the type of media being used.  
From the toolbar click Media. 
 

The following media list will open.  
This media list holds Medias that have been certified by Uninet. 
After selecting the type of material and the texture of your media roll, click on the type of media that 
will be used or match it to the Media ID. 

 

*To create or edit custom media please refer to the appendix  
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c. Sensor Calibration 
      (for die cut media only)  

 

Die cut media with gaps in between labels will use the Gap Sensor. 
(see Step 2 of 6) 

 

 

 

 

 
 
Die cut with black lines on the back will use the Back Sensor. 
Die cut with black lines on the top will use the Top Sensor. 
 
 (see Step 2 of 6) 

STEP 1  
 
 
 

 

• In APEX2Print select Die Cut Mode. 
• If printing on regular media, Die Cut mode 

does not need to be selected. 
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STEP 2  

 
 

 
 
 

• Select correct sensor according to the type of 
media being used. 

• If the calibration sensor is red, you must 
calibrate the media. 
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STEP 3  
 

 
 

Red Arrow: Where the sensor is located. The media needs to pass through here to be calibrated. 
Blue arrow: Is the place where the media should be before calibration. 
For calibrating media that uses the Back and Top sensor, line up the Black Marking on the paper (shown in the 
photo as the blue arrow) about one inch below the sensor (Red arrow). 
For Gap Sensor: Line up the gap (Blue arrow) of the labels about one inch from the sensor (Red arrow). 
Give some slack to the roll of paper directly underneath the sensor before calibrating. This ensures the rollers are 
not pulling the weight of the roll while calibrating. 

STEP 4  

 
 
 

 

When the media is properly loaded and the sensor has been chosen, select Calibrate Sensor. 
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STEP 5  
 

 
 

• Select Run Calibration to start the auto calibration. The printer will run the paper 
about 6 inches to the nearest gap or black mark. 

• To use the values previously stored in the feeder from the last use press Copy Feeder 
Settings To Media Library. 

• You can also manually input the values for Sensor Window and gain under the Media 
Library Settings. Then select Copy Media Library Settings to Media Library to update 
the values to the feeder. 

*Note that only the right side (Media Library Settings) can be modified.  
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STEP 6  
 

 
 

• After calibration manually rewind the roll until the paper is inside the red arms 
• The feeder will read Require Load. 
• Press the Load button 
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10. Printing 
 

a. Adding Label Image 
 

The Apex2Print program uses PDF format only.  

To open a file simply Drag and Drop your PDF image file to the preview screen or you may also choose 
the Open File button or choose File > Open 

 

b. Selecting amount of Labels 
 

Before printing, choose how many labels you 
want to be printed and click Add.  
APEX2Print will automatically round the amount of labels up to complete a full row. 
 
Once ready to print, click Print. 

c. Alignment (Start Position) 
 

For the first print, you will need to adjust vertically where the printer starts printing the labels. 
 
1. Print more than 20” (50.8cm) of labels for the first print. 
Make sure the proper values for paper width, gutter and 
alley measurements are inserted into APEX2Print. 
 
 
2. Check the start position 20” (50.8cm). The 20” of header 
color patterns for calibration. The gap in between labels 
should be in line with the gap on the label or back sensor 
line.  
If the labels are not aligned after the third copy, adjust the 
start position value according to how far the label is from 
the gap. 
 
• Start Position  Positive Value (+): moves print down 

     Negative Value (-): moves print up 

 
NOTE: For other information on print options such as nesting, Rip Rotating and Rip Scaling, please 
refer to the appendix  
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d. Printing 
 

 

 

 

 

  

STEP 1 of 4  
 
 

 
 
 

Click Open File and select a PDF file or multiple PDF files all of the same dimensions (the selected files 
will be displayed in the Preview Screen). Notice that multiple files are aligned in columns. Once all 
PDF files have been added and the entire page Information adjustments have been made click Print. 
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STEP 2 of 4  
   

 
 

If a previous media width was used with your feeder, the feeder guide will retain that width. If the 
new media width is not the same size then the Feeder / Media Size Mismatch window will display. 
Select OK to Unload Media (If there is no media loaded this action still needs to be completed).  

STEP 3 of 4  
   

 
 

After the media unload action has completed press Done on the feeder unit> Click OK to print. 
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STEP 4 of 4  
   

 
 

If Done is not selected on the feeder unit the printer will remain in a busy state and display a Feeder 
Not Ready window> Press Done on the feeder unit> Click OK. 
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Appendix 
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ICOLOR 900 Specifications 

ICOLOR 900: System Specifications 
Print Speed Up to 9.14 meters/min (30 ft/min) 
Technology Single Pass 4 Color LED (CMYK) 
Printer Processor1 800/133 MHz 
Media Width2 Minimum: 3.0 inches ( 76.2 mm) 

Maximum: 12.9 inches (327.7 mm) 
Print Width Minimum: 3.0 inches (76.2 mm) 

Maximum: 12.6 inches (320 mm) 
Print Length Up to 420 meters (1378 ft) 
Substrate Types3 Die Cut Label Stock 

Kiss Cut Label Stock 
Non Die Cut Label Stock 
Tag Stock 

Print Quality 1200 x 600 dpi 
Toner Supplies4 CMY - 16,500 pages @ 5% 

K - 18,500 pages @ 5% 
(Rated according to ISO/IEC 19798 guidelines) 

Drum Supplies5 CMYK - 42,000 pages @ 5% 
(Rated according to ISO/IEC 19798 guidelines) 

Feeder System Input roll maximum outside diameter: 12 inches (305 mm) 
Core inside diameter: 3 inches (76.2 mm) 
Maximum input roll weight: 60 lbs (27.2 kg) 
Cut on the fly, auto cut 
Auto page width registration 
Front Panel LCD interface 
Web management system torque 
Auto adjusting form synchronization 

Rewinder System Output roll maximum diameter: 12 inches (305 mm) 
Core inside diameter: 3 inches (76.2 mm) 
Maximum output roll weight: 60 lbs (27.2 kg) 

Dimensions (H X W X D) Printer & Feeder: 46.3" x 25.7"x24.9" (1177 mm x 654 mm x 633 mm) 
Rewinder: 16.4" x 19.7" x 21" (415 mm x 500 mm x 533 mm) 

Weight Printer & Feeder: 337.8 lbs (153.2 kg) 
Rewinder: 30 lbs (13.6 kg) 

Operating Environment Temperature: 10°C to 20°C (50 to 89.6°F) 
Humidity: 20 to 60% RH 

Power 110 - 127 VAC, 50/60 Hz @ 880W 
220 - 240 VAC, 50/60 Hz @ 440W 

Certifications FCC Class A, CE, cTUVus, CCC 
Warranty 1 year – Parts & Labour 
Hard Disk 40 GB internal disk 
Memory 512 MB, optional 1GB 

1. Published performance results based on laboratory testing. Individual results may vary. 
2. Must use Narrow Fuser. 
3. This product is designed and engineered to operate only with genuine Uninet consumables and certified media substrates. Please 

contact Uninet for the most current Certified Media List of substrates available. 
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Die Cut Media Instructions 
 

The following is a detailed guide to creating an over sized label image on top of a die cut label. The term 
over bleed is used which means that there is a small portion outside of the actual label known as the 
“overprint area”. Excess ink of the label is printed on to this area so that the actual dimensions of the 
label are met with clear, clean cut edges. The cutting is done after we print. 

In digital die cut printing with over print or printing into the gap and alley we actually cut the label first 
and print over top the substrate. 

 

Here is how you do such a procedure: 

                               
  

The Trim Box is the size of the die cut label. The die cut dimensions are of course the choice of the 
printer and can be ordered from any converter. 

4. Letter-size sheets at 5% coverage. Printer ships with a 7,500 page set of starter toners. 
5. Based on 500 cut-sheet pages/job. 

Uninet reserves the right to change product specifications without notice. Trademarks are the property of their respective 
manufacturers. ©2013 Copyright, Uninet. All Rights Reserved. All content is subject to change without notice. 
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In this example we have a die cut with dimensions of 101.9h x 101.9w that we received from a 
converter. The overprint area is 1mm larger than the actual label on all sides, thus adding 2mm total to 
the height and 2mm total to the width. This gives us a label image size of 103.9 x 103.9. 

 

 

The gap and alley are each measured at 3.175. 

TBh  – Trim Box height  TBw – Trim Box width  MBh – Media Box height  MBw – Media Box width 

G – Gap or Gutter  A – Alley 

Here is how you calculate for the new gap and new alley used for over bleed. 

TBh + G – MBh = New Gap    and    TBw + G – MBw = New Alley 

101.9 + 3.175 – 103.9 = 1.175         101.6 + 3.175 – 103.9 = 0.875 

Add these figures into APEX2Print with the gap sensor on and mm selected. Make sure you have a good 
delta reading from your sensor calibration routine. Once you have done the calibration you do not need 
to run it again. 

Start position and left/right will be a separate adjustment. 

Run a test Job. On the third page observe the start position and adjust it so the image is approximately 
1mm above the die cut label. Do the same for the left/right position; make sure that down the left hand 
column you see the image outside the die cut label by approximately 1mm. 

You should now be running a full bleed label. You will see movement as per spec but every label should 
stay within the limits. 
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Feeder Menu Summary 
 
a. Changing Menu Settings 
1. To use the Menu you must first press offline. 
2. Press Menu (far right button).  Use the Arrow buttons to move up & down through menu items. Press Select. 
3. To choose a selection – press Select – you will see a pointer on the left margin that will blink.  Press up or 

down arrow to change options.  Press Deselect to save changes (blinking will stop) 
4. To Exit – scroll down to exit, then select. 

 
**If at any time you need to re-boot the printer without turning the unit on and off by the rear power switch, press 
and hold the middle button for >2 seconds.  Printer will go into soft power off mode. Press middle button again 
(holding for >2 seconds) and printer will perform reboot sequence. 
 
 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

PAGE 1 

 

 

PAGE 2 
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PAGE 3 
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b. Feeder Error Messages 
 

Help Button 

Your printer has a built-in help system. When an error message appears on the display, press HELP. The display 
shows information that will help you correct the error. Use the ∇ key to move down through the Help information. 
 

Feeder Error Messages 

Errors 1 to 9 – Emergency Stop, Control PCB Internal Errors 
If the feeder menu displays errors 1 to 9 ensure that all doors on the cart are closed completely and the media is 
loaded into the printer correctly.  Also ensure that the media is located under the media sensors. If the feeder 
menu continues to display this error, remove all media and reboot the printer. 
 
Errors 10 to 19 – Media load, unload, and feed errors 
If the feeder menu displays errors 10 to 19 check the media path and ensure that the media is loaded into the 
printer correctly also ensure that the media is located under the media sensors. If the cart menu continues to 
display this error, remove all media and reboot the printer. 
 
Errors 20 to 29 – Swing Errors 
If the feeder menu displays errors 20 to 29 check the media path and ensure that the media is loaded into the 
printer correctly and the media is located under the media sensors. If the feeder menu continues to display this 
error, remove all media and reboot the printer. 
 
Errors 30 to 39 – Cutter Errors 
If the feeder menu displays errors 30 to 39 check the media path and ensure that the media is loaded into the 
printer correctly. If the feeder menu continues to display this error, reload the media and ensure all the proper 
settings have been set.  
 
If you still receive an error message please contact Uninet Service Support by phone 1-866-415-4797, or by email 
support@Uninet-label.com. 
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 Using the Printer Menu 
a. Changing Settings 
 

 

 
The steps involved in using the menus are typically as follows:  
 
1. Ensure that the display panel indicates that the printer is ready to print.  
2. Enter user menu mode by pressing either the Enter button or the Up-arrow or Down-arrow button and press 
the latter two repeatedly until the desired menu is highlighted in the displayed list.  
3. Press the Enter button to select this menu.  
4. Press the Up-arrow or Down-arrow buttons repeatedly until the desired Item is highlighted.  
5. Press the Enter button to select this Item.  
6. Press the Up-arrow or Down-arrow buttons repeatedly until the desired Value is highlighted.  
7. Press the Enter button to select this Value. (If you are setting a parameter, ensure that an asterisk (*) appears 
beside the selected parameter Value.)  
8. Press the Online button to exit menu mode and return to the ready to print status.  
 

b. Buttons and Lights 
 

• Shutdown/Restart button Hold down for more than 2 seconds for a soft shutdown. You can then press this 
button again for a restart or use the Power switch to turn off the printer completely. 

• Ready light  On: indicates ready to print  
 Flashing: indicates processing print data  
 Off: indicates unable to receive data (offline)  
• Attention light  Off: indicates normal operation  

  Flashing: indicates error(s) present but printing can continue  
  On: indicates error(s) present and printing cannot continue  

• Display panel Displays status and setup information for the printer and user help information in your chosen 
language  

• Up-arrow button Enters menu mode and enables upward movement through the displayed list of menu items  
• Down-arrow button Enters menu mode and enables downward movement through the displayed list of menu 

items  
• Back button Returns to the previous higher level menu item  
• Enter button Enters menu mode and selects the menu item highlighted in the display panel  
• Online button Switches between online (printer ready to receive data) and offline (printer not ready to receive 

data) 
• Cancel button Cancels current print job  
• Help button Provides additional textual or image data to supplement what is displayed on the display panel 
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c. Display Panel Messages 
 

MESSAGE COMMENT  
Ready to Print Your printer is online and ready to print.  
Printing  Your printer is printing and paper is currently being fed from Tray 1 or MP Tray.  
Near End The paper supply in the tray is low and will run out soon. 
Toner Low The remaining toner of color is running low. 
Fuser Unit Near Life The fuser unit is nearing the end of its working life. Change Fuser unit because 

the fuser unit has reached the end of its working life and has to be changed. 
Inverter is Removed The Inverter unit has been separated from the printer and all finisher functions 

are disabled. (Finisher/Inverter is an optional accessory.) 
Invalid Data 
Press ONLINE Button 

Invalid data has been received by the printer. Press the ONLINE button to clear 
this warning. 

Change Paper 
Press ONLINE button 
Please see HELP for details 

There is a mismatch between the media in the tray and print data. Load media of 
size into tray. The message may remain for some time after you have closed the 
tray. You can have the printer ignore this error for the current print job by 
pressing the ONLINE button. You can access help details by pressing the HELP 
button. 

Install Paper  
Please see HELP for details 

The printer has tried to take paper from an empty tray. Load media of size into 
tray 1. The message may remain for some time after you have closed the tray. 
You can access help details by pressing the HELP button.  

Install Tray The printer has tried to take paper from a tray that has been removed. Ensure 
that tray is correctly located or put tray loaded with paper back into the printer.  

Open Cover Paper Remains  
Please see HELP for details 

Additional paper has been detected after a paper jam has been cleared. Open 
side cover to check for additional paper. You can access help details by pressing 
the HELP button.  

Check Image Drum  
Please see HELP for details 

Check that the image drum of color is correctly installed. You can access help 
details by pressing the HELP button. 

 
 
There are four types of display panel message:  

a.) Status information  
b.) Menu (functions) information  
c.) Configuration information  
d.) Help information  

 
a.) Status Information  

Status information is associated with three printer states:  
• In the Information state, such as idling or printing, the printer is able to process print jobs.  
• In the Warning state, the printer has encountered some minor problem but is still able to process print jobs.  
• In the Error state, the printer has encountered a problem and cannot continue printing until the user has 

intervened and removed the cause of the trouble.  
The top two lines of the display panel show the printer status. The bottom of the display panel normally 
shows a bar chart of the toner usage.  
 

b.) Menu (Functions) Information 
There are three types of menu (functions) information:  

• User menus: accessed by pressing the Enter button, Up-arrow or Down-arrow button on the control panel. 
These menus are available to the general user to make various settings that are used in the running of the 
printer.  
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• Administrator menu: accessed by pressing the Enter button for more than 2 seconds while turning on the 
printer power supply (including restart). Available to administrator level users. Restricts the changes that 
general users can make via the user menus.  
• System maintenance menu: accessed by pressing the Up-arrow and Down-arrow buttons together for 

more than 2 seconds while turning on the printer power supply (including Restart). Available to support 
staff to allow printer configurations and special functions to be set.  
 

c.) Configuration Information  
Configuration information displays printer configuration information such as internal firmware versions.  
Menu options at each level can be scrolled through by moving the highlight with the Up-arrow/Down-
arrow buttons and a highlighted option at that level can be selected by pressing the Enter button. When 
the lowest level menu has been selected, you can change the setting for that menu by selecting the 
required highlighted value from a list or by entering a numeric value. In other cases, you can display or 
print configuration information. 
 

d.) Help Mode  
When an error has occurred, press the Help button. Information will be displayed that will help you correct 
the error. 

 
 

 
d. Setting Media Type for All Print Jobs (Defaults) 

 
1. Press Enter. 
2. ∇ key → Menus. Press Enter. 
3. With Tray Configuration highlighted, press Enter. 
4. ∇ key → tray to be configured. Press Enter. 
5. Use the ∇ and Enter keys to scroll through the submenus and to make your setting changes. 
6. Press ON LINE to exit the Menu Mode. 
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How to create and edit new Media ID/Custom Media ID  
 

a. Creating New Media  
 

 

 

 

 

 

 

STEP 1 of 5  
 

 

 
 
 

To create a new media, click Media Tab on the APEX2Print toolbar> Select the correct media ID and right 
click on any Media ID.  
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STEP 2 of 5  
  

 
 

The Creating a New User Media Entry window will open. Note: All 3 User Media fields must be filled 
before a new media entry can be updated into the media list. 
STEP 3of 5  
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Notice that the User Media fields have been filled and the Update/Create This Media button is now 
available. Make the necessary adjustments to the Media Type field and the Media Weight. Please check 
the Appendix for a media guide description. When the necessary changes have been made click 
Update/Create This Media. 

STEP 4 of 5  
 

  
 
The new media will be displayed in the Media List. 
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b. Editing a newly created Media ID  
 

 

STEP 5 of 5  
 

  
 
There is an option that allows for only the new media to be displayed. Check the Show Only User Media 
box to view only new/custom media IDs. 

STEP 1 of 4  
 

 

 
 

If the new media entry needs to be edited, right click on the new Media ID 
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STEP 2 of 4  
 

 

 
 
 

The Creating a New User Media Entry window will display. Click Edit. 

STEP 3 of 4  
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Make the necessary changes to the User Media fields> Click Update/Create This Media.  Notice the Delete 
This Media button. 

STEP 4 of 4 
 

 

 
 

To delete a new Media ID, ensure that the media for deletion is not loaded. An Error Deleting Active Media 
window will display the warning displayed above. Click OK> Click Media> Select another Media ID to load> 
Click Media> Right click on the new Media ID for deletion> Click Delete This Media. 
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Replacement of Consumables and Maintenance 
 
a. Replacing the Fuser 

STEP 1  STEP 2 
  

 

CAUTION: The Fuser may be hot.  
Lift the Blue tab up to unlock the fuser.  

 Using the handle, gently Lift the fuser out of the 
printer 

 
 
 
 

b. Replacing the Transfer Belt 
STEP 1  STEP 2 

 

 

 

Turn off the printer.  Open the top cover. 
CAUTION: The fuser is very HOT after the printer has 
been printing. Be careful not to touch it! 
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STEP 3  STEP 4 

 

 

 
Remove the four image drums/toner cartridge 
units and place them on a flat surface. 

 Cover them with dark paper or plastic to protect them 
from light. 

 
 

STEP 5  STEP 6 
 

 

 

 
Lift the transfer belt latches to release them.  Grasp the blue handles and lift the transfer belt out. 

Dispose of it in accordance with local regulations. 
 

STEP 7  STEP 8 

 

 

 
Unpack the new transfer belt, grasp the blue handles 
and lower the left side of the belt into the printer, 
fitting the pins into the guides at the front and back, 
then lower the right side. 

 Push down on the belt latches to lock the new belt in 
place. 
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STEP 9  STEP 10 

 

 

 
Put the image drum/toner cartridge units back into 
the printer. 

 1. Close the top cover. 
2. Turn the Printer on. 

 
 
 

c. Replacing the Waste Toner Bottle 
STEP 1  STEP 2 

 

 

 
Open the door and remove the waste toner bottle.  Follow the instructions on the label to ensure 

proper disposal.  
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d. Cleaning the LED Heads 
 

Note: Clean the LED heads: 
• Any time you replace a toner cartridge 
• If printing is showing signs of faded images, white stripes or blurred letters 

STEP 1  STEP 2 

 
 

  

 

Open the top cover. 
 

 Use the LED cleaner provided with the toner 
cartridges or a soft, lint-free cloth to gently wipe 
each of the four heads (1). Move the cleaner as 
shown, using a fresh section for each pass. Be 
careful not to damage the guards (2). When 
finished, close the top cover. 
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Printing Options  
 

a. Nesting  
 

Being able to print multiple images on your current media at the same time.  

 

 

  

STEP 1 of 10  
 

 

Click the Nesting Tab. Notice that the Add and Edit buttons have become available and the Print 
button is now labeled Print Nesting.  
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STEP 2 of 10  
 
 

 
 

From the APEX2Print toolbar click Nesting> Click Open File and select a PDF file, or multiple PDF files 
of the same dimensions/size (the selected files for nesting will be displayed in the Preview Screen)> 
Click Add and the PDF/PDFs will be removed from the Preview Screen (The job will be stored for 
printing). The Print Nesting button will now display Print Nesting: 1. 
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STEP 3 of 10  
 
 

 
 
 
From the APEX2Print toolbar click Nesting> Click Open File and select a PDF file, or multiple PDF files 
of the same dimensions/size (the selected files for nesting will be displayed in the Preview Screen)> 
Click Add and the PDF/PDFs will be removed from the Preview Screen (The job will be stored for 
printing). The Print Nesting button will now display Print Nesting: 2. 
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STEP 4 of 10  
 
 

 

Continue to repeat the process in Nesting: Step 1. From the APEX2Print toolbar click Nesting> Click 
Open File and select a PDF file, or multiple PDF files of the same dimensions/size (the selected files 
for nesting will be displayed in the Preview Screen)> Click Add and the PDF/PDFs will be removed 
from the Preview Screen (The job will be stored for printing). The Print Nesting button will now 
display Print Nesting: 3. 
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STEP 5 of 10  
 
 

 
 
Notice that 3 jobs have been nested with the Print Nesting: 3 button indicator. If needed, click on Edit 
to make additional changes to the nested jobs.  
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STEP 6 of 10  
 
 

 
 
 
The Nesting Options Window will open. Notice that adjustments can be made to impact the white space of a 
label, controlling where on the label that jobs are printed. The quantity of labels can also be adjusted across 
each nested job. Once the necessary changes have been made click Update> Click Exit. 
 
Beginning of the Plot - For finishing printers, media must pass a certain distance through the printer before 
printing can occur. 
 
Between Nested Jobs - When printing nested jobs it can be very difficult to differentiate between similar 
images such as barcodes. Adjustments can be made to allow a space of one label between nested jobs. 
 
End of the Plot - This value will remain as the same value from the Beginning of the Plot; this will allow for a 
new job to be printed after the last job has completed resetting to the same distance that is required before 
printing can occur. 
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STEP 7 of 10  
 
 

 
 
The job is ready for printing. Click Print Nesting:#. 
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STEP 8 of 10  
   

 
 

If a previous media width was used with your feeder, the Feeder Guide will retain that width. If the 
new media width is not the same size then the Feeder / Media Size Mismatch window will display. 
Select OK to Unload Media (If there is no media loaded this action still needs to be completed).  

STEP 9 of 10  
   

 
 

After the media unload action has completed press Done on the feeder unit> Click OK to print. 
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STEP 10 of 10  
   

 
 

If Done is not selected on the feeder unit the printer will remain in a busy state and display a Feeder 
Not Ready window> Press Done on the feeder unit> Click OK. 
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b. Rip Rotate Options 
 

 

 

 

 

 
  

STEP 1 
 
 

 
 

 
 

When the Rip Rotate Option is set to 0 all PDF files will preview in their original orientation. The Rip 
Rotate Options will allow for the desired orientation. 
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STEP 2 
 
 

 
 
 

Select the desired rotation value> Click Clear in the 
Image List section. 

 STEP 3 
 
 

 

Click Open File>Select the PDF for rotation. 
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STEP 4 
 

 
 

The rotation has been applied to the PDF. Adjustments can now be made in the page Information section 
for correct placement on the Selected Media. 
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c. Rip Scaling Options 
 

 

 

 

 

  

STEP 1 
 
 

 
 

Select the desired scaling values> Click Clear in the 
Image List section. 

STEP 2 
 
 

 

Click Open File> Select the PDF for scaling. 
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STEP 3 
 
 

 
 
 
The Preview Screen will display the scaled object. 
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Paper Sensor Error Codes 

(i) Help Button 
Your printer has a built-in help system. When an error message appears on the display, press HELP. The display 
shows information that will help you correct the error. Use the ∇ key to move down through the Help information. 
 

(ii) Feeder Error Messages 
Errors 1 to 9 – Emergency Stop, Control PCB Internal Errors 
If the feeder menu displays errors 1 to 9 ensure that all doors on the cart are closed completely and the media is 
loaded into the printer correctly.  Also ensure that the media is located under the media sensors. If the feeder 
menu continues to display this error, remove all media and reboot the printer. 
 
Errors 10 to 19 – Media load, unload, and feed errors 
If the feeder menu displays errors 10 to 19 check the media path and ensure that the media is loaded into the 
printer correctly. Also ensure that the media is located under the media sensors. If the cart menu continues to 
display this error, remove all media and reboot the printer. 
 
Errors 20 to 29 – Swing Errors 
If the feeder menu displays errors 20 to 29 check the media path and ensure that the media is loaded into the 
printer correctly and the media is located under the media sensors. If the feeder menu continues to display this 
error, remove all media and reboot the printer. 
 
Errors 30 to 39 – Cutter Errors 
If the feeder menu displays errors 30 to 39 check the media path and ensure that the media is loaded into the 
printer correctly. If the feeder menu continues to display this error, reload the media and ensure all the proper 
settings have been set.  
 
If you still receive an error message please contact Uninet Service Support by phone 1-866-415-4797, or by email 
support@Uninet-label.com. 
 

(iii) Feeder Panel Error Messages 
 

Message   Issue 

Msg: Guide Door Open Ensure Guide Door is Closed 

Msg: Guide Tray Out Push Guide Tray Completely into the Feeder. Ensure 
Guide Tray Latches are Locked. 

Msg: Close Guide Tray  

  

Ensure Guide Door is Closed 

Msg: Close Door/Tray 

 

Push Guide Tray Completely into the Feeder. Ensure 
Guide Tray Latches are Locked. 

Msg: Funnel Full Remove all Paper from the Guide. 

        

    

Msg: Path Full Remove all Paper from the Guide. 
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(iv) Feeder Panel Errors 
  

Error Issue Solution 

Status: Error 00 Emergency stop (guide door opened 
during motor movement) 

Close Door on Feeder 

Status: Error 01 Switch panel communication error Contact Service: 1-866-415-Uninet 
(4797) Status: Error 02 Internal error Contact Service: 1-866-415-Uninet 
(4797) Status: Error 03 Internal error Contact Service: 1-866-415-Uninet 
(4797) 

Status: Error 10 Media not found over lower load 
sensor after load 

Do a sensor calibration(p.57 in the 
manual) or remove paper in path 

Status: Error 11 Media not positioned between load 
sensors properly after load advance 

Check that media tension is not too 
tight 

Status: Error 31 Cutter did not leave home position in 
required time 

Check paper jam in cutter 

Status: Error 32 Cutter did not finish cut in required 
time or can't home it 

Check paper jam in cutter 

 
 

Clearing Paper Jams 
 
If you are experiencing frequent paper jams, check the following items. 
• Is the printer level? 
• Is the media you are using within specification? Media that is too light or too heavy will often cause jams. 
• Are the settings (printer and driver) appropriate for the media being used? 
• Do not use creased or curled media. 
• Remove the media from the tray. Fan and align the stack. Replace the media. 
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(i) Tray Side Cover 
 

STEP 1  STEP 2 

 

 

 

Hold the tab, turn the paper guide outward. 
 

 Remove the paper jam. 

 
 
 
 

STEP 3 

 

Close the paper guide. 
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(ii) Printer Side Cover 
 

STEP 1  STEP 2 

 

 
 

 
 

 

Open Side Cover  Pull release lever and open side cover. 
 
 
 
 
 

STEP 3  STEP 4 

 

 

 

Remove the paper jam.  Close the side cover. 
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(iii) Printer Top Cover 
 

STEP 1  STEP 2  

 

 

 

Squeeze top cover handle  Squeeze basket handle and raise drum basket. 
 
WARNING: Be careful not to touch the fuser unit 
which may be hot after printing. If the fuser unit is 
hot, wait until it cools before attempting to 
remove any jammed paper. 

 
 
 
 
 

STEP 3  STEP 4 
 
 

 

 
 
 

 

Remove the paper jam.  Unlock the fuser and remove from the machine by 
lifting upwards. 
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STEP 5  STEP 6 
 

 

 

 

Pull up jam release levers to release paper  Turn the lock lever to lock fuser unit. 
 
 
 
 
 

STEP 7  STEP 8 

 

 

 

Open the face-up stacker  Open side cover (paper exit) 
 
 
 
  

 

Release levers 
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STEP 9  STEP 10 

 

 

 

Close side cover, and then face-up stacker  Close image drum basket. 
 

STEP 11 

 

Close the top cover. 
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(iv) Roll Paper Jams 
 

STEP 1  STEP 2 

 

 

 

If you have a paper jam, press Help to find out the error 
code. 

 
 

Open the Side Cover. 

STEP 3  STEP 4 

 

 

 

Locate the paper jam.  Open the Guide Door and Guide Cover.  Open the 
two Guide Channels and Load Door. 
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STEP 5  STEP 6 
 

 

 

Open the Media Door of the feeder. Lower the Extension 
Arm. Using both hands, rewind the paper roll until the 
yellow LED light on the feeder menu begins flashing. 
At this time, you want to ensure the tension on the 
paper roll isn’t too tight and the roll isn’t damaged or 
coning. 

 Reload media. 

 
 Avoiding Paper Jams 
 
The following table summarizes possible causes of paper jams and suggests ways of avoiding them.  
 
POSSIBLE CAUSE SUGGESTED REMEDY 
The printer is not level. Place the printer on a steady, level surface. 
Your print media is too light or too heavy. Use appropriate media 
Your print media is damp or charged with static 
electricity. 

Use media that has been stored in appropriate temperature 
and humidity conditions. 

Your print media is creased or curled. Use appropriate media. Decurled media can be used. 
Your print media sheets are not aligned with 
each other. 

Remove the sheets, jog them into alignment and reload them. 

Your print media is not aligned properly in the 
paper tray. 

Adjust the paper stop and paper guides of the tray, or the 
manual feed guide on the MP Tray to align the media properly. 
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Correcting Print Quality Defects 
 

SYMPTOMS POSSIBLE CAUSES STEPS TO TAKE 
Vertical white lines 
can be seen on the 
printed page. 

The LED head is dirty. Wipe the LED head with a LED lens cleaner or with a soft 
cloth. 

The toner is low. Replace the toner cartridge. 
Foreign materials may be 
present in the image drum. 

Replace the image drum cartridge. 

Light-shielding film of the 
image drum cartridge is 
dirty. 

Wipe the film with a LED lens cleaner or with a soft cloth. 

Printed images are 
fading vertically. 

The LED head is dirty. Wipe the LED head with a LED lens cleaner or with a soft 
cloth. 

The toner is low. Replace the toner cartridge. 
The paper is not suitable for 
the printer. 

Use recommended paper. 

Printing is light or 
faded. 

The toner cartridge is not 
properly seated 

Reinstall the toner cartridge. 

The toner is low. Replace the toner cartridge. 
The paper is moist. Use paper stored in proper temperature and humidity 

conditions 
The paper is not suitable for 
the printer. 

Use recommended paper. 

Thickness and type of paper 
are inappropriate. 

Set a proper value for [Media Weight] and [Media Type] in 
the menu setup, or set one value thicker for [Media 
Weight]. 

Partially faded 
images. White 
spots and lines 
appear in solid 
printing. 

Paper is moist or dry Use paper stored in proper temperature and humidity 
conditions 

Vertical lines 
appear. 

The image drum cartridge is 
damaged. 

Replace the image drum cartridge. 

The toner is low. Replace the toner cartridge. 
Horizontal Lines 
and spots appear 
periodically. 

When the interval is about 
94mm (4in), the image 
drum (the green tube) is 
damaged or dirty.  

Wipe it lightly with a soft cloth. Replace the image drum 
cartridge when it is damaged. 

When the interval is about 
42mm (1.5in), there may be 
foreign particles in the 
image drum cartridge. 

Open/close the top cover, and print again. 

When the interval is about 
87mm (3.5in), the fuser unit 
is damaged. 

Replace the fuser unit. 

The image drum cartridge 
has been exposed to light. 

Replace the image drum cartridge if the problem is not 
resolved. 

White area of 
paper is lightly 
stained. 

Paper contains static. Use paper stored in proper temperature and humidity 
conditions. 

The toner is low. Replace the toner cartridge. 
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Periphery of the 
letters is smudged. 

The LED head is dirty. Wipe the LED head with a LED lens cleaner or with a soft 
cloth. 

Toner comes off 
when it is rubbed. 

The thickness and type of 
the paper are incorrectly 
set. 

Set the correct value of [Media Type] and [Media Weight] 
in the menu setup or set one value thicker for [Media 
Weight]. 

Glossiness is not 
uniform. 

The thickness and type of 
the paper are incorrectly 
set. 

Set the correct value of [Media Type] and [Media Weight] 
in the menu setup or set one value thicker for [Media 
Weight]. 
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Removing Glue Residue from the Feeder Unit 
 

After printing there may be a build-up of adhesive on the guide arms, extension arms and cutter blade.  As a result, 
the roll will stick and create excess back tension when feeding, causing load failures, bad cuts and unfavorable 
output.   
If you are seeing the following: 

a) The roll is not fully rotating or seems to stick to the back guide arm 
b) The media is not feeding at a constant speed/rate 
c) The feeder blade does not have a clean cut 

 
To fix the three problems shown below, you will need to use 99% isopropyl alcohol and a Kimwipe to gently wipe 
each of the surfaces until the adhesive and residue are removed.   
For access to the cutter blade you will need to remove the cutter blade cover by unscrewing all five screws. Using 
caution, wipe the cutter blade until all residue is removed. Return the cutter blade cover to its original position and 
retighten the screws.  Reload media and continue printing 
 

The following pictures give examples of where glue residue can build up. 

Example #1 – Back Extension Arm 
 

 

 

  

 

 

Glue Residue 
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Example #2 – Guide Arms 

 

  

 

Example #3 – Cutter Blade 

 

 

 

  

Glue Residue 

Glue Residue 
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Adjusting Guide Width 
 

STEP 1  STEP 2 

 

 

 

Feeder control panel should now be back at the 
Offline screen: 

 Press the Online/Offline button which will cause the 
feeder to unload the media (it will do this if there is 
media loaded or not). 

 

STEP 3  STEP 4 

 

 

  
Once the unload operation is complete, the control 
panel will show this screen: 

 Open the Media Door.  Pull the plunger to release 
the Extension Arm.  Drop the Extension Arm down, 
and remove the media roll if one is loaded: 
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STEP 5  STEP 6 

 

  

 
Leave the Guide Arm down. 
 
Close the Media Door, and press Done on the control 
panel. 

 The Extension Arm will automatically adjust to 
12.375” wide. This is not wide enough for 12.90” 
(327.66mm)   wide media, so a manual adjustment 
can be made. 
 
Wait for the Extension Arm to finish adjusting. 

 

STEP 7  STEP 8 

 

 

 

Press the Online/Offline button so the control panel 
shows this screen: 
 
PRESS and HOLD the Guide button for approximately 
3 seconds. 

 The control panel should now look like this: 
 
Press the Open button 60 times (each press opens 
the Extension Arm an additional 0.25mm.) 
 
The Extension Arm will now be open approximately 
12.975” (329.57mm) wide. 
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STEP 9  STEP 10 

 

 

 

Open the Media Door. Insert a roll of 12.90” 
(327.66mm) paper as shown, ensuring you’re holding 
the roll on the side and making sure the core is flush 
with the media.  Ensure the outside edge of the roll is 
flush with the inside core.  If this is not done 
properly, there will be tracking problems. Ensure the 
roll is pushed all the way into the feeder against the 
back Extension Arm. 

 Lift the Extension Arm back up into position making 
sure both the Plunger and Extension Arm lock. 

 

STEP 11  STEP 12 

 

 

 

The Extension Arm should be rubbing on the roll 
slightly to provide some back tension (drag). If it is not, 
Press the Close button on the control panel a few times 
until the Guide Arm is rubbing slightly. 

 
 
 
 
 

Open the Load Door at the bottom front of the 
feeder by releasing the two yellow latches. 
 

Guide Channels 

Tension Swing 

Load Door 
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Open the Guide Cover and Guide Channels. Feed 
the paper under the orange Tension Swing as 
shown. 
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STEP 13  STEP 14 

 

 
 

Place the paper three quarters of the way up the 
path so the paper has covered the paper sensors 
completely. 
 
Place the paper evenly between the Guide 
Channels and hold it steady with one hand. 
 

 Ensure the Channel Gap (the distance between the 
edge of the paper and the Guide Channel) is less than 
0.5mm on each side and the paper aligned with the 
right side Guide Channel. 
 
Ensure the Channel Gap is not too small so that the 
paper does not fit between the Guide Channels.  The 
paper should lay flat against the back of the feeder. 
 
Use the Open and Close buttons to make an 
adjustment if necessary. 
 
Close the Guide Channels, Load Door and Guide Cover. 

 

 

 

 

 

 

 

  

Channel Gap 

105 



STEP 15  STEP 16 

 

 

 

 
PRESS and HOLD the Exit button for 3 seconds to exit 
out of the guide adjust mode. 
 
Press the Online/Offline button to go back Online. 
 
Close all covers and doors except the Guide Door. 
 
 

  
The control panel should look like this: 
 
Press the Load button to load the media.  
 
The roll will begin to load and cut off a section for 
proper alignment.  Open the cutter door and while 
using caution, carefully remove the piece of cut 
paper. Close the cutter door. 
 
Note: Depending on the type of media being used, 
the paper may fall inside the feeder.  Use caution 
when retrieving cut media. 
 
CAUTION: Do not place hands  
inside machine while printing or  
cutting. Keep hands away from  
the cutter blade. 
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STEP 19  STEP 20 

 

 

 

Press the Done button.  The control panel screen should look like this after 
the load finishes: 

 

 

 

STEP 17  STEP 18 

 

 

 
 

The control panel screen should look like this after a 
few moments: 
 
 

 Open the Cutter Door and remove the cut piece of 
waste paper. 
 
Close the Cutter Door. 

 

Remove cut 
piece of media. 

107 



STEP 21 

 

Close the Guide Door and the system is ready to print 
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Manually Adjusting the Guide Width 
 
Why is this important? 
When the media is not tight between the guides, there may be movement along the X-axis and result in graphics 
being out of registration or possible errors in the feeder.  Ideally, the Channel Gaps should be less than 0.5mm on 
each side of the media.  These instructions can be used as a quick fix for gaps that are below 0.25” wide.  If the gap 
is larger than that, go back to the software to adjust the overall width of the roll. 
 

STEP 1 

 

This image shows that the guides are too wide for the media.  We will manually adjust the guides using the 
panel on the feeder. 

 

 

STEP 2 

 

First you must press Online to access the Menu. 

The gap is too wide to 
feed properly. 
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STEP 3 

 

The status should now be Offline.  Press Guide. 
 

 

STEP 4 

 

Select Open or Close to manually adjust the guide to the proper width.  Each time open/close is pressed, the 
guides open 0.01” (0.254mm). Once this is done, select Exit. 
 
Note: You may need to open and close the Guide Channels, Load Door and Guide Cover to see how tight the 
media is between the Guide Channels. 

 

 

 
 

 Uninstalling APEX2Print  
For Software Upgrade: Use this uninstall before installing the new upgrade 
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STEP 1 of 4 
 

 
 

Start Menu> Control Panel. 

STEP 2 of 4 
 

 
 

Click on Programs and Features. 

STEP 3 of 4 
 

 
 

Select APEX2Print> Right Click> Select Uninstall. 

STEP 4 of 4 
 

 
 

 
Click Yes on the window prompt. APEX2Print will 
uninstall. 
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Troubleshooting 
 

a. How to Change the Settings: User 
 

It should be noted that many of these settings can be, and often are, overridden by settings 
in the Windows printer drivers. However, several of the driver settings can be left at “Printer 
Setting”, which will then default to the settings entered in these printer menus.  

 
Where applicable, factory default settings are shown in bold type in the following tables.  
In the normal operating condition, known as “standby,” the printer’s LCD window will show 
“Ready to Print”. In this condition, to enter the menu system, press the up and down Menu 
buttons on the operator panel to move up and down through the list of menus until the 
menu you wish to view is displayed. Then proceed as follows:  
 
1. Press Enter to enter the menu. 

2. Use the up and down MENU buttons on the control panel to scroll through the menus. 
When the item you want to change is displayed, press Enter to view the sub-menus for that 
item. 

3. Use the up and down MENU buttons to move up and down through the sub-menu items. 
When the item you want to change is displayed press Enter to display the setting. 

4. Use the up and down MENU buttons to move up and down through the available settings 
for the sub-menu item. When the item you want to change is displayed press Enter to 
display the setting. An asterisk (*) will appear next to the setting, indicating that this setting 
is currently in effect. 

5. Do one of the following: 

•  Press Back again to move up to the list of menus; 
or… 

•  Press Online or Cancel to exit from the menu system and return to standby. 
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b. How to Change the Settings: Administrator  
 

You can set whether to ENABLE or DISABLE each category in the user menu. 
Disabled categories are not displayed in the User’s menu. Only a system administrator can change 
these settings.  
 
1. Turn OFF the printer. Turn ON the printer while pressing the Enter button.  When Boot Menu 

appears, take your finger off the button. 

2. Press the Enter button. 

3. At the Enter Password prompt, enter the 4-9 digit Admin password.  (The default password is 
aaaaaa). 

(a) Using the up and down MENU buttons, scroll to the required letter/digit. 

(b) Press the Enter button to input and move to the next letter/digit. 

(c) Repeat steps (a) and (b) until all letters/digits are entered. 
4. Press the Enter button. 

5. Press the up or down MENU button until the “category” you want to change is displayed. 

6. Press the Enter button. 

7. Press the up or down MENU button until the “item” you want to change is displayed. 

8. Press the Enter button. 

9. Using the up or down MENU button, identify the parameter as required. 

10. Press the Enter button to enter an asterisk (*) on the right side of the setting selected. 

11. Press the Online button to switch to online. The machine will automatically re-boot. 
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c. Exit Speed Adjustment 
 
If the image is smearing, increase the exit speed. 

STEP 1  STEP 2 
 

 
 

  

 

Select Menu on the printer  menu.  Scroll down the menu and select Calibration. 
 

 
STEP 5 

 

 
 

Adjust the exit speed by increasing the number in 
increments of two.  Select Enter and then Online.   

 

STEP 3  STEP 4 
 

 
 

  

 

Scroll down the Calibration menu.  Select Exit Speed Adjustment. 
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